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1.1. Précautions préliminaires

e Une connaissance basique d'Internet, de Windows et d'un traitement de texte sont utiles

e Pour debuter faites simple sinon simpliste. Vous ajouterez vos effets visuels et autres
fantaisies lorsque vous posséderez les outils de base.

e La connaissance d'un éditeur Html n'empéchera jamais de connaitre les balises source
du langage Html [oui, je sais, je me répéte... mais toutes les "signatures" du Web vous le
diront].

1.2. FrontPage 2000

FrontPage 2000 de Microsoft est un des meilleurs éditeurs de pages Html du marché. I
présente l'avantage énorme de reprendre l'interface de Microsoft Word et fournir une
passerelle vers les différents produits de la marque Microsoft dont Microsoft Office. Les
puristes du Html regretteront qu'il "écrit" surtout pour Microsoft Internet Explorer et qu'il y a
parfois des probléemes de compatibilité sous Netscape. D'autres (dont I'auteur) regretteront
sa facon trés personnelle, et parfois un peu déroutante, de concevoir une page Web.
FrontPage 2000 est néanmoins un produit trés complet et trés performant. Notre but ici
n'étant pas de faire une aide détaillée de FrontPage, nous nous cantonnerons
volontairement aux fonctions élémentaires afin de réaliser une premiére prise en main.

FrontPagg,

MICROSOFT OFFICE

1.3. Plan du site

Toujours dans un esprit didactique, ce site comprendra une page de présentation de l'auteur
(c-a-d vous) et 3 "sous-pages” consacrées a son chanteur préféré, ses loisirs préférés et un
portrait chinois.

Page de
présentation

: }

Chanteur Loisirs Portrait
préféré préférés chinois
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1.4. Mise en place des pages du site

e OQuvrez le programme FrontPage. 2000
Démarrer > Programmes > Microsoft FrontPage

e Fichier > Nouveau > Site Web. Nous mettrons ainsi tous les éléments de notre site
(pages Html, images, etc.) dans le méme dossier (soit siteFrontPage).

Fichier Edition Affichage Insertion Formakb  Outils Tableau

Mouveau L4 DI Page... Chrl+n
o Cirl+0 JM
i Eermer Ctrl+F4 .

Sites Web |

.,'] Site Web normal =

] Szsistant [mportation de zites Web Options
@ | Azsistant Site Web d'entreprise Indiquez I'emplacement du nouveau site
& | Site Weh d'assistance 3 la clientéle D

_r] Site Web dun projet Iments'\Mes gites WebhaiteFronPage j
g :!:E EEE pf;rs-:unnel ™| Ajauten aw site bet actif
B | Sike Web vide

I™ | Cornesion secunzes (S5 neceszaie

Drescription

Crée un houveal zite YWeb composé
d'une zeule page vide.

Ok, I Annuler

Comme indiqué sur la capture d'écran, indiquez comme emplacement du nouveau site
Web :

C:\Mes Documents\Mes sites Web\siteFrontPage.

o FrontPage en créant le répertoire de votre site (siteFrontPage) a aussi créé un fichier
index.htm.

Ce fichier (la page de présentation) sera la page d'accueil [ou homepage] de votre site.
Par convention, on appelle toujours ce fichier "index.htm" ou "index.html".

Ouvrons ce fichier. Fichier = Ouvrir = siteFrontPage - index

I ] siteFronPage j

_private
|ma|;|es
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Nous devons donner un titre a cette page Web. C'est le titre qui apparaitra tout en haut
dans la fenétre du navigateur. Bouton droit > Propriétés de la page > onglet
"Général" > Titre "Mon site Internet".

Propriétés de la page EH

Gengral I.ﬁ.rriére-planl Margesl F'ersu:unnaliserl Languel Groupe de travail I

Emplacement : Ifile:.-";".-"E:.-"M ez Documentz Mes sites WeblzteFronFaged

Titre:: IM:::n site [nkernet

Fichier > Enregistrer pour enregistrer la page avec cette modification.

e On ouvre une nouvelle page Web en cliquant sur JI
l'icbne de nouvelle page. Commencgons par la ( j'ﬂ— -
4 s z . '|:|||- - -
page consacree au chanteur preféré. Un conseil, [ .- page
utilisez toujours des minuscules pour vos noms de
fichiers.

£ - [d

n

On enregistre directement cette page (vide) : Fichier > Enregistrer sous... avec comme
Nom de fichier "chanteur".

Enregistrer sous HE |
Enregistrer dans ||:| siteFronPage j 4= ‘ s I - Outils -

oy _private

@ ! images

Hiskorique inde:x

Titre de la page : Mouvells page 1 Modifier. ..
Mom du Fichier : Ichanteur | E Enreqistrer I
Type de fichier : IPages ‘Web j annuler |

On doit encore donner un titre a la page. Cliquez Modifier... comme indiqué sur la
capture d'écran et dans la nouvelle fenétre qui se présente indiquez comme titre de la
page "Mon chanteur préféré".

Définir le titre de la page |

Titre de |a page :

IMl:nn chanteur préféré

Le titre de |a page apparait dans la barre de titre du

navigateur,
[o]4 I Annuler |
Vous pouvez maintenant Enregistrer— R —¢rregstrer |
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On reprend la méme procédure pour les autres fichiers. Faites 0> Enregistrer sous...
et toujours dans "SiteFrontPage" donnez comme Nom de la page, le nom de "loisirs".
Modifier... et comme Titre de la page "Mes loisirs préférés". Enregistrer.

On reprend toujours la méme procédure pour le dernier fichier. Faites 0> Enregistrer
sous... et toujours dans "SiteFrontPage" donnez comme Nom de la page, le nhom de
"chinois". Modifier... et comme Titre de la page "Mon portrait chinois". Enregistrer.

1.5. La page de présentation (index.htm)

Revenons a la page de présentation. Pour ce faire, on peut (notamment) passer par
Fichier =+ Ouvrir 2 dossier "SiteFrontPage" = index ou Fichier —> Fichiers récents >
index.

On retrouve la mention "index.htm dans le
bord supérieur gauche de la fenétre de
I'éditeur.

indes. hitrn

Tapez maintenant dans la fenétre principale : "Mon site Internet" que I'on met en
surbrillance.

G (24 pts = [

On met en taille 6 soit , en gras et on centre . On profite aussi de la

, A |, .
surbrillance pour mettre le texte en couleur ==i"| par exemple en bleu marine..
On passe a la ligne (nouveau paragraphe = Enter).

On entre ses coordonnées soit :

Karmali Hussein (nouvelle ligne = Maj + Enter)
Rue du "Petit Site", 169 (Maj + Enter)

7700 Mouscron (Maj + Enter)

Belgium

On peut modifier le format de ce texte. Mettre le texte en Surbrillance. On prend par
exemple, une taille 5 et on désactive le bouton "Gras". On passe a un nouveau
paragraphe [enter]

On va maintenant créer un tableau (invisible) d'une ligne et d'une colonne.

Vous découvrirez bien vite que les tableau sont des éléments trés importants pour le
design d'une page Web et que leur usage est donc trés fréquent.

Tableau = Insérer - Tableau et reproduisez les données suivantes.
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Inzérer un tableau EHE |

Taillz

Lighes : 1 =i Colormes ; 1 =i
Diizpozition

Alignement : IEentré "I ¥ Specifier la largeur :
ST o I o

.. ¥ En pourcentage
Marge intérieure 0 -
des cellules : =i

E spacement Iﬁ
entre les cellules : =l
Style. . | k. I Annuler

¢ On clique dans la zone du tableau et on demande une liste a puces

On encode alors ¢ Mon chanteur préféré
e Mes loisirs préférés
e Mon portrait chinois

¢ Nous allons maintenant effectuer les liens (pour rappel, Html est hypertexte). Nous allons

relier "Mon chanteur préféré" a la page "chanteur.htm".

Mettez "Chanteur préféré" en surbrillance et cliquez l'icobne de lien hypertexte
Insertion > Lien hypertexte et reprenez le fichier chanteur.htm.

Créer un lien hyperntexte EE

Chercher : I‘ﬁ giteFronPage j
| Mam | Titre

ifide. kit bon gite Inkernet

chanteur. htm bon chanteur préféré

chinoiz. htm ton portrait chinoiz

lizirz. bt Mes losirs préférés

On procéde de méme pour "Mes loisirs préférés" et pour "Mon portrait Chinois".

e On peut modifier la taille du tableau. Bouton droit > Propriétés du tableau.

Propriétés du tableau H |

Dizpozition
Alignement IEentré j ¥ Spécifier la largeur :
. -
Elattement : IF'ar défaut j |35 En pigels

¥ En pourcentage

Marge inténeure des ||:| 3: - Spéﬁier Ia hatew -

cellules :

Ezpacement entre les - ||:| %) Erpieels
cellules ; II:I E -

) Erpourcentage
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On peut aussi ajouter un fond de couleur a la page. Format > Arriére-plan ... ou Bouton
droit > Propriétés de la page > onglet Arriére-plan.

Propriétés de la page |

Général Armigre-plan | Margesl F'ersu:unnaliserl Languel Groupe de travail I

Mize en forme
[ Image d'amiére-plan
I™ | Erriere-nlam statigue

I Barcourr.... Erapneies..

[ Activer les effetz de substitution povr le lien hypertexte

Stulede substitutiun...l

Couleurs
Arrigre-plar ; I [] ,&,utgmatiuejs\l Lien hypertexte : I | .-'-‘-.ut::umatiquej
Texte : I | .ﬁ.utnmatiquej Lign visité : | .ﬁ.utnmatiquej

Lier actif : B Zuomatigue j

] I Annuler |

Veillez que votre couleur de fond soit toujours compatible avec votre couleur de texte. Si
les golts et les couleurs ne se discutent pas, votre texte et votre présentation doivent
toujours rester lisibles.

Enregistrez votre travail. Fichier > Enregistrer ou ™

1.6. La page "Mon chanteur préféré" (chanteur.htm)

Passez par Fichier —+ Ouvrir pour ouvrir la page chanteur.htm.

Pour faciliter la vie du lecteur, on inclut des "outils de navigation" pour lui permettre de se
mouvoir dans votre site sans passer par les boutons "Précédent" et "Suivant" de son
navigateur Internet. Dans le cadre de ce travail, nous utiliserons, dans un premier plan,
des mots pour faire les liens mais il est plus sympathique a I'avenir de prévoir des petites
images.

Tapez "Page d'accueil". Surbrillance et alignez a droite

Profitons de la surbrillance pour effectuer également le lien vers la page de présentation.

Activation de l'icbne de lien L , puis sélection dans le dossier "SiteFrontPage" du fichier
index.htm.

Créons un nouveau paragraphe (enter) et demandons l'alignement au centre . On
encode le titre (& ne pas confondre avec le titre de la page Web, celui qui apparait dans le
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haut de la fenétre du navigateur) soit "Mon chanteur préféré". On peut lui donner la taille
5, le mettre en gras et lui donner une couleur.

e Nous allons insérer un tableau. Menu Tableau = Insérer = Tableau. Entrez toutes les
spécifications comme ci-dessous.

Taille
Lignes : I1 _I? Colonnes : 1 =i
Dizposition
Alignement ; IEentré vI ¥ Spécifier la largeur
N

. " En pourcentage
Marge intérieure 5 -

des cellules : =1
Ezpacerment Iﬁ
entre lez cellules ; =i

La case "Marge intérieure des cellules" entourera le texte des bords du tableau de 5
pixels d'espace libre.

e Et si nous donnions un fond de couleur au tableau ? Lorsque votre curseur est dans la
tableau, Bouton droit 2> Propriétés du tableau.

Arigre-plan
Couleur : II:l futamatique

[ Utilizer une image d'aisre-plan

Vous encodez alors dans la cellule du tableau vos préférences concernant votre
chanteur préféré et les commentaires qu'il vous inspire.

¢ On enregistre son travail. Fichier - Enregistrer ou E
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1.7. Premier test dans le navigateur

e A ce stade vous pouvez déja admirer I'ébauche de votre site sous un navigateur. Soit

Fichier > Apercu dans le navigateur ou

Vous devez avoir quelque chose qui ressemble a ceci :

Mon site Internet

Karmali Hussein

Rue du Petit Site, 169
7700 Mouscon
Belgium

e Mon chanteur préféré

e Mes loisirs préférés
e Mon portrait chinois

Page d'accueil

Mon Chanteur préféré

Jacques Brel

"la pluie est
traversiere"

Vérifiez en cliquant sur "chanteur préféré" de la page de présentation, si le lien vers
"chanteur" est bien actif. De méme, dans la page chanteur, en cliquant sur "page

d'accueil", vous devez revenir a la page index.

1.8. La page "Mes loisirs préférés" (loisirs.htm)

Passez par Fichier —+ Ouvrir pour ouvrir la page loisirs.htm.

¢ On n'oublie pas de mettre les outils de navigation. Tapez "Page d'accueil". Surbrillance.

Et alignez a droite

Créons un nouveau paragraphe (enter) et demandons l'alignement au centre
encode le titre soit "Mes loisirs préférés".

. Activation de l'icbne L pour le lien et sélection dans le dossier
"SiteFrontPage" du fichier index.htm.

. On

On peut lui donner la taille 5, le mettre en gras et lui donner une couleur pour garder une
certaine identité graphique par rapport aux autres pages.

En Html, tout est tableau! Pour une mise en page efficace, les tableaux sont

incontournables. Nous profiterons donc de cette page pour faire plus ample connaissance

avec les tableaux.

Notre but sera de réaliser la présentation suivante.

La Formule 1

La souris

La sieste

On demande un tableau de 3 lignes et 3 colonnes.

Indiquez aussi les autres spécifications comme dans la capture d'écran.
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Inzérer un tableau |

T aille

Lignes ; I3 _Ij Colannes ; 3 =
Digpozitian

Alignement ; IEentré - I ¥ Spécifier la langeur ;

Taille d= la = ‘e .

bordure I1 = IED S =S

. * En pourcentage

targe inténieurs £ =

dez cellules : =l

E zpacement =

entre les cellules : ==

Shyle... | 2k, I Annuler

e Cliquez sur la premiére cellule en haut a gauche. Entrez le texte que vous souhaitez.
Ensuite, Bouton droit > Propriétés de la cellule.

Propriétés de la cellule |
Dizpozitian
&lignerment horizontal ; IEentré vI V¥ Spécifier la largeur :

Alignement vertical : Milies |33 ™ En pixels
(Ol

I'I 3: ™ Spécifier la hautear":
|-| 3: ||:| ) Erpieels

) Erpowrcentage

-

Mambre de lignes par
cellule :

Mombre de colonnes
par cellule ;

[ Cellule d'en-téte
[ Pas de renvoi & la ligne

Bordures

Couleur : ||:| j Bordure claire : I. .ﬁ.utnmatiquej

Bordure foncée : I ] .ﬁ.utnmatiquej

Arrigre-plan

Couleur I—=l

[ Utilizer une image d'amiére-plan

I Parcounr... | Erapnetes.. |
Style. . | k. I Annuler | Appliguer |

On peut déterminer les attributs d'alignement et donner une couleur d'arriére-plan (par
exemple jaune) et une couleur de bordure (par exemple vert).

Remarque pour les puristes du Html et de la compatibilité des navigateurs. Si la couleur des bordures
apparait bien dans Internet 4.0 et plus, celle-ci ne s'affichera pas chez les visiteurs de votre site qui utilisent
Netscape. Ces problémes de compatibilité entre les différents navigateurs et leurs différentes versions sont
assez fréquents et constituent tout I'art d'un bon Webdesigneur.
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On procéde de méme pour la cellule centrale et la cellule inférieure droite.

Et nous terminerons par linsertion d'une ligne horizontale. Insertion - Ligne
horizontale.

En cliquant sur la barre horizontale, faire Bouton droit - Propriétés de la ligne
horizontale pour configurer cette ligne. Soit une largeur de 60 %, une hauteur de 5, un
alignement centré et une couleur (qui n'apparaitra pas sous Netscape) verte.

Propriétés de la ligne horizontale |

T aille

Largeur : Iﬂ * Pourcentage de fenétie
" Piuels

Hauteur : |5 3: Fizels:

Alignement

Couleur :

" Gauche O Cenbe = Draite

I T j ¥ Ligne pleine [pas d'ombrage)

Style. . | k. I Annuler

Enregistrez votre travail. Fichier - Enregistrer ou ™.

1.9. La page "Mon portrait chinois" (chinois.htm)

Passez par Fichier -+ Ouvrir pour ouvrir la page chinois.htm.

On n'oublie pas de mettre les outils de navigation. Tapez "Page d'accueil". Surbrillance et

alignez a droite = Activation de licéne % et sélection dans le dossier
"SiteFrontPage" du fichier index.htm.

Créons un nouveau paragraphe (enter) et demandons l'alignement au centre . On
encode le titre soit "Mon portrait chinois". On peut lui donner la taille 5, le mettre en gras
et en couleur.

On insére un tableau de 5 lignes et 2 colonnes selon la procédure maintenant habituelle.
Entrez les autres spécifications suivantes.
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Taille

Lignes : |5 _Ij Colonnes ; Z =

Dizpozition
I IEentré 'I IV Spécifier la larger :
Taille de la —] ~ _
bordure ; |5 =i I?E En pizels

Marge intérieure 5 -

dez cellules : I =1
Eszpacement Iﬁ
entre lez cellules : =i

¢ Vous obtenez un tableau qui prend la forme ci-dessous que vous complétez..

Couleur préférée Le blen

Acteur preféré Twes Montand
Actrice préferée Pamela Anderson
Chiffte prefére Le?

Pays prétéré L'Espagne

e Enregistrez tout votre travail (oubli classique). Fichier =+ Enregistrer ou ™.

e Votre exercice sur la création d'un site est ainsi terminé. En fait, maintenant que vous
possedez les outils de base, tout commence vraiment !

e En attendant votre véritable premier site, admirez toujours celui-ci dans Explorer (ou dans
Netscape...).

e Ouvrir Microsoft Explorer. Pour ce faire cliquer son icéne.
Pour rappel, puisqu'il s'agit d'un fichier local, on passera par Fichier > Ouvrir >
Parcourir - chemin d'accés au répertoire "SiteFrontPage" -» fichier index.htm
- Ouvrir.

1.10. Pour terminer ...

Les images sur Internet doivent étre au format gif ou jpeg.

Comme vous étes slrement habitué au format bmp des traitements de texte, il vous faudra
passer par un programme graphique pour faire les conversions. L'auteur vous recommande
Paint ou Microsoft PhotoEditor, disponible en principe dans windows.

Pour commencer, vous pouvez toujours récupérer des images au cours de vos surfs sur le
Web. Il suffit de cliquer sur l'image, bouton droit de la souris —* Enregistrer I'image
sous...
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Ouerir Lien

Ourerir I8 lien dans une Mowvele fenétre
Enreqistrer la cible sous. ..

Imprimer Cible

Afficherlimage

Erwegiztrer lmage sous. ..
Etablir en tant que papier peint k

Une fois que vous avez votre image au format correct, enregistrez-la dans le méme
répertoire que vos fichiers Html (ici "Site FrontPage" sous-répertoire "Images").

Pour inclure I'image dans votre page Html, il suffit de faire Insertion > Image > A partir

du fichier ou cliquer sur l'icbne e de la barre d'outils.
Sélectionnez I'image.

Image

Chercher : I'a images

| Mom I Titre I
if i images/PLUBHTM. qif

URL : [images/PUBHTM gi = Ql @|
] I Annuler LClipdurt. .. Parametres. .. | Scanner... |

Cliquez sur I'image, Bouton droit > Propriétés de I'image.

Dans I'onglet Général, on peut sous la rubrique Texte prévoir le texte qui apparaitra dans
I'infobulle lors du survol de l'image et éventuellement prévoir un lien sur l'image sous la
rubrique Lien...
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Propriétés de l'image EEA

General |"Ji|:|é|:| I .-’-'-.pparenu:el

Source de l'image :

[images/PUBHTM g Parcouri... |  Modfier... |
Type
+1GIF 7| Transparent ¢ JPEG  Qualité 7H =

j
4 IF

[V Entrelace Pazzes progressives
" PHG

Reprézentations de remplacement

Bazze I

2 ] Parcourir. .
résolution ; =

Teute : IF'uI:nIin::atin:nn Htro
Lien h%erte:-:te par défat

Emplacement : I Farzourir...

Cadre de I
destination :

Shyle... |

L

k. I Annuiler

Dans l'onglet Apparence, on demandera de spécifier la taille pour accélérer le processus
d'affichage de la page par le navigateur.

Général| Vidéo  Apparence |

Digpozition

Alighement ; IF'ar défaut 'I E zpacement harizantal : IEI 3:

E paizzewr de bordure ; IEI 3: E zpacement vertizal ; 0 -

T aille

: Hautewr : IBE Eﬁ
['\} ' en pixelz & en pixels

™ en pouncentage " en pourcentage
¥ Congzerver les proportions

k. I Annuler

N'oubliez pas que la taille des images est I'ennemi de la vitesse de la connexion. Inutile de
prévoir des photos panoramiques de votre école qui mettront 10 minutes pour étre chargées
sur votre page Web. Votre visiteur sera vraisemblablement déja en train de surfer sur un
autre site que le votre !
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Avant de quitter les images, le langage Html vous offre la possibilité de mettre de
petites images en arriére-plan [background] qui viendront tapisser votre fond de page
en mosaique.

Ces images peuvent aussi étre récupérées sur le Web. |l suffit de cliquer sur le fond de la
page, bouton droit de la souris > Enregistrer I'arriére-plan sous...

Erecederte
Sliarte

Enregistrer ['amiére-plan sous. ..

Etablir en tant que papier peint h

Pour l'inclure dans votre page, Format > Arriére-plan ou Bouton droit > Propriétés de la
page 2 Onglet Arriére-plan.

Général Amigre-plan |Marges| F'ersu:unnaliserl Languel Groupe de trawvail I

Mize en forme
¥ |mage d'amiére-plan
[ Amiére-plan statique

[ Activer lez effetz de substitution pour I ien hppertexte

Eropnetes,.. |

Dans I'état actuel de la technologie, le navigateur n'affichera réellement que les polices de
caractéres qui existent sur l'ordinateur du visiteur de votre site. La prudence et le classicisme
s'imposent donc (Times New Roman ou Arial). Il serait illusoire d'utiliser des polices de
caracteres trés sophistiquées que votre "client" ne posséde peut-étre pas sur sa machine.

Le code source Html

Vous pouvez a tout moment voir (et modifier) le code source Html de votre page que vous
éditez sous FrontPage par Affichage = Afficher les balises ou sur l'icone suivante au bas
de la fenétre de I'éditeur.

[ Mormal £ HTHML [5dpercu /

Il serait trés pédagogique de consulter ce code Html aprés chaque opération (centrage, mise
en gras, alignement droite, création de tableau).

FrontPage propose encore certaines fonctions qu'il sera bien temps d'utiliser plus tard (et
parfois bien plus tard ...).

Citons-en simplement quelques-unes :

e Fichier > Publier le site Web. Permet de "uploader" votre site sans changer de
programme.

Initiation & Microsoft FrontPage 2000® - ARAT 2003-2004 - Karmali 15



Affichage > Barre des Affichages pour oter la barre d'affichage qui (a notre avis)
encombre un peu fa fenétre de I'éditeur.

Insertion > Composants permet d'ajouter un compteur d'acces, du texte défilant, des
boutons sensitifs, etc. On prétera attention a la compatibilité des ses éléments sous
d'autres navigateurs.

Insertion > Base de données. Pour Webdesigners avertis.

Insertion = Formulaires.

Format > Effets DHTML. On prétera attention a la compatibilité des ses éléments sous
d'autres navigateurs.

Format 2> Transitions de pages. Effets de transitions de pages mais seulement sous
Explorer.

Tableau avec d'utiles propriétés comme la fusion de cellules, la fraction de cellules ou
I'uniformisation de la largeur des cellules.

Cadres pour fractionner la fenétre du navigateur [frames].
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